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1.  What's new in Win-EQF* version 3 ?

Below is a list of features and changes as of  March 25, 2015. This document is intended 
as a quick introduction for users upgrading to Win-EQF* v. 3.xx from previous versions. 

Please note that this list is compiled from the HISTORY.TXT file which comes with 
Win-EQF*, available from the Help > Revision history menu item.

1.1.1.  Win-EQF* changelog 

Changes in Win-EQF* v. 3.01 - March 25, 2015

1. Minor changes to the IOTA library - added AS-200 entity (tnx WB3LHD).
2. Changes to the ADIF import/export "save as" and "open" dialogs, now 

including "all files" wildcards  in the file type lists (FILE-EQF.EXE). 
3. Updated ENTITY.LIB / Niue (tnx N1BCL). 
4. Corrected bug in PRINT TEST LABEL routine.
5. Improved support for QSL & SWL labels for satellite QSOs (tnx N6RM).

Changes in Win-EQF* v. 3.00 – December 28, 2014

1. Minor changes to the prefix library (tnx K1XN, WB3LHD).
2. Registration/license key routines removed – program released as 

DONATIONWARE.
3. Improvements to internal command processing/message loop.
4. Updated URL for QRZ.com XML data retrieval.
5. The Win-EQF* contest module is officially retired – no further 

enhancements will ever be made to this part of the program.

NOTE: The default install folder of Win-EQF* v. 3.xx remains C:\WIN-EQF2. 

NOTE: Win-EQF* is NOT freeware. Win-EQF* is now DONATIONWARE. Refer to 
HELP > ABOUT for details. 

Changes in Win-EQF* v. 2.35 - March 24, 2014

1. Minor changes to the IOTA library (tnx WB3LHD).
2. Minor changes to the prefix library (tnx K1XN).
3. Minor correction to setup/station location entry dialog (tnx W3GQ).
4. Added support files for dedicated label printer, type Brother QL-710W

(QL-710W-1.INI).
5. Removed a lot of "dead code".

Changes in Win-EQF* v. 2.34 - November 23, 2013

1. Fixed bug in the LoTWUploader which did not store all configuration settings.
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Changes in Win-EQF* v. 2.33 - November 12, 2013

1. Minor changes to the user's manual.
2. Minor changes to the prefix library (tnx K1XN).
3. BACKUP.EXE utility now includes registration code details (tnx W8BFG).
4. Added RIG definition files for FT-DX1200, FT-DX3000 and FT-DX5000.
5. LoTWUploader: Added support for LoTW/TQSL v. 2.0, 

removed support for TQSL v. 1.xx.

Changes in Win-EQF* v. 2.32 – September 11, 2013 

1. Minor changes to the user's manual.
2. Minor changes to the prefix library (tnx K1XN, K1PL).
3. Added shortcut to access the LoTW processing queue status page from the 

LoTWUploader.
4. Added support for TQSL version 1.14.3 (download here: 

http://www.arrl.org/instructions ).
NOTE: For the LoTWUploader to work correctly, users are required to update to the 
latest TQSL version (v. 1.14.3 or later).--- NOTE: refer to changelog for v. 2.33.

5. Revised SECTIONS multiplier file for use with field day contest module (updated 
Canadian sections). Separate download of contest definition files required - NOT 
included with the program patch – download from win-eqf.com (tnx K1PL).

6. Added backup of the registration key to the backup routine - the file REGCODE.TXT,
which is an ordinary text file, will contain your registration details. Please 
store this information in a safe place.

7. Minor changes to the ABOUT screen.
8. New HAMCAL32.DLL file due to changes in the HamCall interface.
9. Corrected some of the bandplan files (tnx ON6KN).
10. Ref. "The Win-EQF.INI file" section of the user's manual - setting 

ImportPropMode=1 will cause Win-EQF* to import the ADIF PROP_MODE field 
(if present) instead of the ordinary MODE field. 

11. Revised ROTOR files.
12. Fixed backup of REGCODE.TXT.
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Changes in Win-EQF* v. 2.31 - March 7, 2013 

1. Minor changes to the user's manual.
2. Minor changes to the prefix library.
3. Improved dupe checking routine. 
4. LoTWUploader now supports ADIF uploads to ClubLog and HamQTH.com.  
5. Included ARGO6.RIG rig definition file for the Ten-Tec Argonaut VI.
6. Added LoTW sent and received fields to ADIF export. 
7. Added JT9 mode in ADIF export routine (tnx PF7M).
8. Updated some of the bandplan files. 

Changes in Win-EQF* v. 2.30 - December 23, 2012

1. Minor changes to the user's manual.
2. Minor changes to File-EQF/LoTW import routine.
3. Minor update to the contest module.
4. Updated ENTITY.LIB (ARRL DXCC entity numbers) and PREFIX.LIB. 
5. Improved dupe checking during logbook sort, solved problem with grid squares 

having a mix of UPPER-/lowercase letters not being recognised as identical (tnx 
NR6M). 

6. Added CATEGORY-STATION to Cabrillo header for ARRL Sweepstakes contests (tnx 
N8IK). 

7. Added optional "force HH:MM:SS granularity" for dupe checking during logbook 
sorts, as requested by avid contesters.

8. Added COUNTY field to dupe checking criteria, as requested by avid contesters.
9. Ref. "The Win-EQF.INI file" section of the user's manual - setting 

StrictDateCheck=ON will cause Win-EQF* to perform a validation of the QSO date 
before the QSO entry is saved, verifying that the date is a valid calendar date. 

10. Updated band plan for North America / 60 meter band (tnx KA9CAR). 
11. Fixed bug in Cabrillo entry form/radio club name (tnx N8IK).
12. Fixed bug in search routine when searching between QSO numbers (tnx WB3LHD).
13. Fixed bug in click-to-edit routine (tnx WB3LHD).
14. Fixed bug in ADIF export of DXCC entity numbers 81, 229 and 230 (tnx G3SWH).
15. Now forcing re-read of CW keyer memories after Alt-X (as requested by N1BCL).

NOTE: From January 1, 2013, replacement registration codes will be charged $15. 
A replacement registration code can only be ordered online at 
http://www.win-eqf.com. Please store your registration details in a safe place - 
and you'll avoid having to order a replacement code. 

Changes in Win-EQF* v. 2.29 - October 22, 2012

1. Minor changes to the user's manual.
2. Fixed QRZ.com XML lookup failure caused by system changes at QRZ.com. 

http://qrz.com/XML/current_spec.html refers.
3. Added RIG definition file for the Elecraft KX3.

Changes in Win-EQF* v. 2.28 - October 13, 2012

1. Minor changes to the user's manual.
2. Minor changes to the prefix library, incl. corrections to VK details (tnx VK5PK).
3. Improved handling of 12m band in DXCC module (tnx N8FTJ).
4. FM is now treated as a PHONE mode in the DXCC module.
5. Fixed bug in callbook database selection (tnx ON6KN).
6. Fixed bug in the LoTWUploader / status bar failed to update.

What's new in Win-EQF* v. 3 ?
http://www.win-eqf.com Page 4 of 22

Rev.: 2015-03-25

http://www.win-eqf.com/
http://www.win-eqf.com/


Changes in Win-EQF* v. 2.27 - September 16, 2012

1. Minor changes to the user's manual.
2. Minor changes to the prefix library (tnx K1XN, LA1YKA, KU4BP, N1BCL). 
3. Added PSK2K mode to ADIF export function (tnx NQ7R).
4. Minor update to some of the menu items.
5. New menu item to delete all online login credentials. 
6. Added QL-700-1.INI label definition file for the Brother QL-700 (tnx W0RAA).
7. Fixed bug in cabrillo routine (tnx W2DAN). 
8. Fixed bug in cabrillo results print (tnx NJ6A).

Changes in Win-EQF* v. 2.26 - July 8, 2012

1. Minor changes to the user's manual.
2. Minor changes to the prefix library.
3. Minor cosmetical changes to parts of the main logging screen.
4. Ctrl-O still toggles between RIG1 and RIG2, but if only one rig is connected,

it will attempt to reset/re-establish rig communication (tnx G0HDB). 
5. Change to the PATCH installer script; users will be prompted whether the 

DDOCML.INI file should be updated/overwritten (tnx N1BCL). 
6. ADIF import via the FILE-EQF utility will prompt the user whether to use default

QSL SENT and QSL RECEIVED values if QSL SENT/RECEIVED values are not present in 
the ADIF source file (tnx W8BFG, VK1DA/2UH). 

7. PSK2K now recognized as a "data" mode (tnx NQ7R). 
8. Revised multipliers for the NC QSO Party contest (tnx KU4BP). 
9. Revised multipliers for the AL QSO Party contest (tnx W6RLL). 
10. Fixed bug in QSL label printing routine/multiple QSOs per label. Broken

in version 2.24 for most other fonts than Courier New (tnx NQ7R). 
11. Fixed bug in EDIT with GOLIST available/re-lookup with F5 caused screen clutter.
12. Fixed bug in cabrillo output for the ARRL VHF QSO Parties (tnx W2YX, W6RLL).
13. Fixed bug in cabrillo info entry screen; now observing maximum line length.
14. Fixed bug in save/retrieve of cabrillo header information. 
15. Fixed bugs in various cabrillo info entry error messages.

Changes in Win-EQF* v. 2.25 - March 19, 2012

1. Minor changes to the user's manual.
2. Minor changes to the prefix library (incl. Z8, R1M).
3. Improved support of dedicated label printers.
4. Setup file for the QL-570 dedicated label printer significantly updated,

please refer to the user's manual for details. 
5. Now supporting multiple QSOs per label printed using a dedicated label

printer. 
6. Added rig definition file for the Icom IC-7410. 
7. Minor changes to the HamQTH.com lookup routine:

- added "prg" parameter to identify Win-EQF* as the client application
- a new session key is requested after 5 minutes, no matter whether the previous
  session key has expired or not.

8. Added shortcut to the Win-EQF* user's manual to the HELP menu. 
9. Fixed bug related to StoreQSLSentDate setting (tnx W8BFG).
10. Fixed bug in the File-EQF utility, now also importing LoTW status from 

ADIF log files *not* produced by the LoTW (tnx N8VZ).
11. Fixed bug in SWL label printing routine (tnx ON6KN).
12. Fixed "out of band" error for "high" 60m frequencies (tnx K1CGZ).
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Changes in Win-EQF* v. 2.24 - January 29, 2012

1. Minor changes to the user's manual.
2. Minor changes to the prefix library.
3. Minor changes to the installer (full program).
4. Minor changes to the help system.
5. Minor updates to various documentation (tnx W8BFG). 
6. Fixed bug in default cabrillo information setup (tnx WB3LHD).
7. Fixed bug in cabrillo export/cabrillo file name occationally causing 

problems.

 
Changes in Win-EQF* v. 2.23 - January 2, 2012

1. Minor changes to the user's manual.
2. Minor changes to the prefix library.
3. Minor changes to the installer (full program).
4. Help system transferred to the HTML Help (CHM) format.
5. Ref. v. 2.19 (12): .ADI or .TXT search outputs are now directed to file names 

LOGBOOKNAME_yyyymmdd_hhMMss.TXT or LOGBOOKNAME_yyyymmdd_hhMMss.ADI. 
6. Improvements to the LoTWUploader helper application.
7. When sending a "x99" report with the CW keyer, the report will now be sent as

"xNN" (tnx N3MVX).
8. Minor cosmetical changes in the File-EQF utility. 
9. Minor cosmetical changes in some of the Win-EQF* screens. 
10. Fixed bug in LoTW/ADIF import for "DATA" mode QSOs.
11. Fixed bug in the installer (patch), which caused some files not to be

updated. 
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Changes in Win-EQF* v. 2.22 - November 29, 2011

NOTE: *** IMPORTANT INFORMATION FOR IOTA ISLAND CHASERS ***

After installing v. 2.22 (and subsequent program patches, though ONLY if you 
are upgrading from a program version older than v. 2.22), you will be required
to rebuild your IOTA award records. Follow this procedure: 
Select Awards > IOTA > Update > Erase > (Yes) > Update > Auto.

1. Minor changes to the user's manual.
2. Minor changes to the prefix library.
3. Minor changes to the IOTA library (tnx G3RFX).
4. Minor cosmetical changes in a number of screens. 
5. Minor cosmetical changes in the File-EQF utility. 
6. Made it technically possible to run multiple instances of Win-EQF* at the 

same time. Not a recommended or supported practice, but made possible as a
result of multiple user requests. 

7. New utility for uploading QSO data to the LoTW. Please refer to the 
user's manual for details (search for "LoTWUploader"). 

8. Ref. "The Win-EQF.INI file" section of the user's manual - setting 
StoreRecentLogs=OFF will keep Win-EQF* from maintaining a list of the 
"last used" log file names.

9. Added rig definition file for the IC-9100.
10. Revised rig definition file for KENWOOD rigs, supporting the CW-R mode.
11. Improved reporting after logbook sort (dupe removal / merging of records /

removing records marked for deletion).
12. IOTA sort order (Awards > IOTA) is now in accordance with the official 

RSGB IOTA list: AF, AN, AS, EU, NA, OC, SA (tnx W6RLL).
13. Fixed bug in the search routine/searching for blank fields (tnx W8KEN).
14. Fixed bug in QSL label printing routine for sprocked-feed labels (tnx W1PR). 
15. Fixed bug causing QSO records not to be properly displayed when 

switching between QUICK and DETAIL VIEW of the logbook (tnx W6RLL).
16. Fixed bug in ADIF export routine - "lost QSOs" (tnx N1BCL, WB3LHD).
17. Fixed bug in the search routine, no longer including deleted QSOs in 

the search. 
18. Please note new postal address for LA6VJA & the Win-EQF* HQ: 

P.O.Box 1036 Jeløy, NO-1510 Moss, Norway

Changes in Win-EQF* v. 2.21 - October 22, 2011

1. Minor changes to the user's manual.
2. Minor changes to the prefix library.
3. Minor changes to the QRZ.com lookup routine:

- added "agent" parameter to identify Win-EQF* as the client application
- a new session key is requested after 5 minutes, no matter whether the previous
  session key has expired or not.

4. Minor changes to the QSO Data interface (MixWInterface.EXE). 
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Changes in Win-EQF* v. 2.20 - October 22, 2011

1. Minor changes to the user's manual.
2. Minor changes to the prefix library.
3. Changed callsign lookup address for HamQTH.com, according to their new 

specification (Alt-W).
4. Added keyboard shortcuts for VOACAP online propagation prediction and online 

coverage prediction (Alt-Z and Alt-R). 
5. Added QSO Data interface (Ctrl-I) for third-party applications. Currently 

supporting (i.e. tested with) QSO Data from MixW v. 2.18, 2.19, 2.20 and 3.01b. 
6. Added bail-out option from contest setup screen (tnx W8BFG).
7. Minor corrections to FILE-EQF (log file import/export utility).
8. Revised the online FAQ (http://www.win-eqf.com > Support).
9. Modified the HamQTH.COM XML lookup in accordance with revised lookup procedure.
10. Minor cosmetical changes in a number of screens. 
11. Fixed bug in dupe QSO display / not responding to mouse click (tnx K1XN).
12. Fixed bug in contest mode RST SENT/RECEIVED input field (tnx W3JXP, KC6MIE).
13. Fixed bug in QSL status display in DXCC status view (tnx WB3LHD).
14. Fixed bug in LoTW/ADIF import related to LoTW SENT/RECEIVED fields and 

duplicate "ghost" QSOs.
15. Fixed bug in QSO quick/detail view, causing a strange visual appearance when used 

with certain fonts.

What's new in Win-EQF* v. 3 ?
http://www.win-eqf.com Page 8 of 22

Rev.: 2015-03-25

http://www.win-eqf.com/


Changes in Win-EQF* v. 2.19 – September 1, 2011

1. Minor changes to the user's manual.
2. Minor changes to the prefix library.
3. EQ-ED - now sorting equipment codes alphabetically.
4. Major revision of the source code, to accomodate PBCC v. 6.02 / PBWin v. 10.02.
5. Fixed bug which caused no update of "time on" when picking spots from the 

DX cluster screen (tnx ON6KN).
6. Added rig definition file for the IC-7200 (tnx K4MLD).
7. Added support for online callsign lookups using the FREE HamQTH.com 

XML service (tnx OK2CQR). 
8. Better support for mixed-mode contests; default SENT/RCVD reports now stored

when switching modes (tnx W1PR). 
9. The TRACK field can now be renamed for ADIF exports requiring additional  

information - such as LoTW/EME QSOs (tnx W6BBS). 
10. Improved handling of accented/international characters. 
11. Changed default filename in the "save as" dialog in the label printing routine. 
12. Search results, when directed to a disk file, now get a unique file name 

for each search (eg. SearchResults_20110823_191811.TXT (or .ADI, if an ADIF 
export), the numbers representing the date and time of the file creation). 

13. A number of files (reports, search results, dupesheets, etc.) generated by 
Win-EQF* will now be placed in the ..\Output folder -- a subfolder to the Win-EQF*
program folder.

14. Changed the definition of a DUPE QSO, as applied when performing a LOGBOOK SORT:
CALLSIGN, DATE & TIME ON, BAND & MODE, TRACK, GRID - if ALL are equal, the QSO is
regarded a DUPE QSO and will be removed during a logbook sort. As before, if 
either of the LoTW SENT/RECEIVED fields contain the letter "Y", DATE & TIME ON is 
considered based on the DDMMYYYYhhmm values. If either field DO NOT contain the 
letter "Y", DATE & TIME ON is considered based on the DDMMYYYYhhmmss values (tnx 
NQ7R). Also see note #5 for v. 2.03.

15. Bug fix in dupe-check sheet generation routine (tnx W3ON). 
16. Bug fix in address label printing (via Search/Ctrl-F - output to QSL labels). 
17. Revised the list of available Telnet DX Clusters - does NOT apply to PATCH 2.19. 
18. Minor bug fixes in FILE-EQF.EXE. 

PLEASE NOTE THAT Win-EQF* VERSIONS >= 2.19 DO NOT SUPPORT THE WINDOWS 95/98/ME OPERATING 
SYSTEMS. 
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Changes in Win-EQF* v. 2.18 - July 15, 2011

1. Minor changes to the user's manual.
2. Minor changes to the prefix library.
3. Minor changes to the IOTA library.
4. Now supporting mode "ISCAT" for ADIF exports (tnx NQ7R).
5. Increased timeout-value for QRZ.com XML lookups.
6. Added support for HamQTH.com lookups (keyboard shortcut ALT-W). 
7. When an IOTA reference is provided by the GOLIST, it will now be 

automatically inserted into the IOTA field of the logbook.
8. New version of the GOWIN32.DLL (v. 2.23) file for GOLIST lookups. 
9. Minor update to the separate collection of contest definition files.
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Changes in Win-EQF* v. 2.17 - June 8, 2011

1. Minor changes to the user's manual.
2. Minor changes to the prefix library.
3. New command-line backup utility. Usage: BACKUP logfile [outPath]  --  will create 

a ZIP archive of the specified logbook file (and associated files, including your 
Win-EQF* settings, etc). The resulting ZIP archive carries a file name which 
clearly identifies the date & time when the backup operation was performed.

4. New utility - EQ-ED.EXE - for those who need to edit Win-EQF* equipment codes - 
for use with a dedicated label printer.

5. Updated ADIF mode translation routine. Win-EQF* mode designator "CONT" now 
resolves to ADIF mode "CONTESTI" and "CHIP6" translates to "CHIP64" (tnx W8BFG).

Changes in Win-EQF* v. 2.16 - May 15, 2011

1. Minor changes to the user's manual.

2. Minor changes to the prefix library.

3. Ref. "The Win-EQF.INI file" section of the user's manual - setting ShortIDTime=ON 
will make the ID timer (CTRL-T) notify you in 5-minute intervals instead of the 
default 10-minute interval. Please refer to the user's manual for details. 

4. Ref. "The Win-EQF.INI file" section of the user's manual - setting AutoIDTimer=ON 
will activate the ID timer once Win-EQF* starts. Please refer to the user's manual
for details. 

5. Ref. "The Win-EQF.INI file" section of the user's manual - setting 
StoreQSLSentDate=ON will use the INFO field to keep track of when the QSL SENT 
field was updated to Y(es), D(irect), B(uro) or M(anager). Please refer to the 
user's manual for details. 

6. Improvements to the backup routine, now also making backup of all .INI files in 
the Win-EQF* program folder. Corresponding changes also in the restore routine. 

7. The SEARCH/PRINT BETWEEN DATES routine now re-displays the last-used values for 
the START and END dates (within the same program instance). 

8. Fixed bug in logbook DETAIL VIEW - now displaying QSO numbers with up to 6 
digits without truncating the QSO number (tnx G3SWH).

Changes in Win-EQF* v. 2.15 - April 23, 2011

1. Minor changes to the user's manual.

2. Minor changes to the prefix library.

3. Ref. "The WIN-EQF.INI file" section of the user's manual - setting KeepTrackInfo 
to ON or OFF will adjust the behaviour of the TRACK field accordingly (tnx OP4K). 

4. Fixed bug in LoTW/OQRS display.

5. Fixed bug in HAMCALL.net lookup/display of birth year.
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Changes in Win-EQF* v. 2.14 - April 7, 2011

1. Minor changes to the user's manual.

2. Minor changes to the prefix library.

3. Added support for Online QSL Request System (OQRS) status indication as provided 
by the GOLIST.

4. Removed menu item "Macro shortcuts" from the help menu. Relevant documentation is
included in the user's manual.

5. Fixed bug in label printing routine (tnx WB3LHD, ON6KN).

Changes in Win-EQF* v. 2.13 - March 27, 2011

1. Minor changes to the user's manual.

2. Minor changes to the prefix library.

3. Corrections to the list of available Telnet DX Clusters.

4. Added Ctrl-B as keyboard shortcut to display WWV info (SFI, A, K values) from 
connected DX Cluster.

5. Reassignment of keyboard shortcut keys:

 - Ctrl-P in CONTEST MODE - as before (paste data from previous QSO)

 - Ctrl-P in NORMAL LOGGING MODE - immediate QSL label print using dedicated label
   printer

 - Ctrl-J will toggle dupe checking ON/OFF, just like SCROLL LOCK does. 
   An increasing number of new PC keyboards come without the SCROLL LOCK key -   

thus Ctrl-J to the rescue. 

6. Corrections and improvements to the QSL label printing routine for dedicated label
printers. 

7. Dupe QSOs are now dumped to unique log files for each sort/dupe removal run (eg. 
DUPES_20110503_090811.LOG, the numbers representing the date and time of the 
dupe file creation). 

8. DX spots picked from the cluster screen will no longer be dupe checked when dupe 
checking is disabled.

9. Last-used value of the TRACK field will automatically be set as the default value 
for the field.

10. Included support for the Green Heron RT-20 / RT-21 rotor controllers (tnx ND8L).

11. Added "Online QSL request submitted" (O) to QSL SENT status codes (tnx W1PR). 

12. Refinements to how the F5 key work when entering/editing QSO data. 

13. Minor change to the PATCH install routine (tnx K1XN). 

14. Minor improvements to the inner workings of the SEARCH function. 

15. Fixed bug in prefix lookup (tnx NZ9Z).

16. Fixed bug in prefix lookup/DX Cluster screen (tnx WB3LHD, K1PL).

17. Fixed bug in online callsign DB/password storage; password length now limited to 
20 characters, as opposed to a maximum of 10 characters in earlier versions.

18. Fixed bug in search routine when output directed to ADIF file (tnx K1XN).

19. Fixed bug in logbook QUICK & DETAIL views (tnx K1XN).
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Changes in Win-EQF* v. 2.12 - February 13, 2011

1. Minor changes to the user's manual.

2. Minor changes to the prefix library.

3. Fixed problem related to program lockup/"freeze" when attempting to delete Telnet 
sites from the list of Telnet DX Clusters. Tnx G3JNB.

4. Fixed problem related to program lockup/"freeze" after viewing Cabrillo results. 
Tnx N8OB.

5. Cabrillo results are now presented in Cabrillo version 3 format.

6. QRZ.com XML (internet) lookups now make use of the QRZ.com-provided "mailing 
country" for address labels.

7. HamCall.net (Buckmaster) lookups now make use of the HamCall-provided "mailing 
country" for address label - provided the database record contains such an item. 

8. Corrections to the list of available Telnet DX Clusters.

9. Logbook restore will also offer to restore program settings (WIN-EQF.INI) from the

backup/ZIP archive.

Changes in Win-EQF* v. 2.11 - January 21, 2011

1. Updated PREFIX.LIB. 

2. Minor improvements to the BACKUP and RESTORE routines.

3. Major corrections to the IOTA library (IOTA.LIB). 

4. Upon master log callsign lookup (MASTER.LOG), the information pertaining to the 
LAST QSO with the station being logged is returned - as opposed to earlier 
versions, which returned QSO data for the first match found. Tnx KN3C.

5. Added support for VUCC/LoTW.

6. Fixed problem with <F5> update Country/QTH in a number of circumstances 
(ref. v. 1.68).

7. Added support for the NRAU Baltic Contest.

8. Minor changes to the user's manual. 

Changes in Win-EQF* v. 2.10 - December 20, 2010

1. Updated PREFIX.LIB.

2. A number of corrections to the Win-EQF* user's manual.

3. Updated contest definition files (available as separate download).

4. Added native support for the Brother QL-570 label printer (QSL/SWL/address 
labels). Will also work with a number of other label printers; please refer to the
user's manual. 

5. Fixed bug in Ctrl-L / click on QSO to edit (tnx W6VY).

6. Fixed bug in label printing routines.
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Changes in Win-EQF* v. 2.09 - December 05, 2010

1. Updated PREFIX.LIB.

2. DXCC entity name now displayed in contest mode (tnx K1CGZ).

3. Updates to a number of dialogs.

4. Fixed bug in country lookup for address label printing. 

5. A number of corrections to the Win-EQF* user's manual.

Changes in Win-EQF* v. 2.08 - November 8, 2010

1. Updated IOTA.LIB, adding SA-099.

2. Updated PREFIX.LIB.

3. Added support for label type Avery 3475.

4. Adjusted margins for label type Avery J8159.

5. Added provision for defining a comment line for SWL labels (apart from standard 
text for QSL labels).

6. File > Print > Label Options; new menu item to allow Win-EQF* to print "Printed 
by..." on QSL labels (if space available). DISABLED by default. 

7. Removed SWL label printing from the menu system.

8. WIN-EQF.INI, GENERAL section, option F8OldStyle can be set to ON or OFF. Setting 
this option to ON will override the new F8/QSL SENT behaviour, simply setting the 
QSL SENT status to "P" no matter what the value already is or how many times F8 is
pressed. Default value is OFF. 

9. When searching ALL AVAILABLE LOGBOOKS, the result list will now contain the 
logbook name in the search result listing when the search result is output to the 
SCREEN.

10. Added JT65A and JT6M as recognized mode designators. 

11. A number of corrections to the Win-EQF* user's manual.

12. Minor cosmetical changes in a number of screens. 

13. Improved distribution of Win-EQF* contest definition files. 

14. Corrected TAB order fault in MANUAL logging when LoTW fields are hidden.
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Changes in Win-EQF* v. 2.07 - October 29, 2010

1. Updated PREFIX.LIB (corrected a few errors). 

2. Updates to the help file.

3. Minor updates to FILE-EQF log conversion utility.

4. Added Alt-M as keyboard shortcut to look up callsign via APRS.fi. 

5. Added Ctrl-P as keyboard shortcut to recall data from last QSO into the logging 
screen (contest mode only).

6. Now displaying the LAST logbook page when doing a QUICK or DETAILED logbook view. 

7. Rearranged the order of menu items in the contest menu.

8. Link to user's manual (PDF file) included in the help system.

9. Link to the online FAQ included in the help menu.

10. New menu item in the IOTA award menu, "View IOTA library in text editor" (as per 
user request ON6KN).

11. Minor cosmetical changes in a number of screens.

12. Fixed bug related to hidden LoTW fields.

13. Fixed bugs in a number of keyboard handling routines.

Changes in Win-EQF* v. 2.06 - October 10, 2010

1. Updated ENTITY.LIB (PJx).

2. Updated PREFIX.LIB (PJx, corrected a few errors).

3. Improved rig support for the Elecraft K3 rig. 

4. Improved routine for QRZ.com and hamcall.net web lookup (Alt-B, Alt-Q).

5. Users who subscribe to the QRZ.com XML service will now have IOTA reference 
automatically entered into the log if this information is present in data returned
from QRZ.com. 

6. LoTW user information is now displayed on-screen if either the GOLIST (if 
installed) or the QRZ.com XML service (if subscribed to) reports that the logged 
station is a known LoTW user. 

7. Fixed bug which in some cases caused the screen to look messy after QSO EDIT. 

8. Fixed bug in contest module, multiplier tracking. 

9. Fixed "visual" bug in DXCC library editor.

10. Added support for Avery 5199 labels (A4), supporting up to 8 QSO lines per label. 

11. Minor change in the label definition for Avery 5261.

12. Added great circle line between "my QTH" and "DX QTH" in the Google Maps lookup.  

13. Renamed the menu item for "Default Reports". 
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Changes in Win-EQF* v. 2.05 - October 2, 2010

1. With reference to Win-EQF* version 2.01, change #11, label printing will function 
as in earlier versions of Win-EQF (up to and including v. 1.94S) if the [LABELS] 
section of the Win-EQF.INI file contains the entry "ManagerPrint=OFF". By default,
this value is set to "ON" by Win-EQF*. Quit Win-EQF* and manually edit the INI 
file if you'd rather like to see your QSL labels printed without the "VIA manager"
text.

2. CONTEST definition files and multiplier files are no longer included in the Win-
EQF* program setup or patches. Instead, these files are available as a separate 
download (CONTEST.ZIP) from the Win-EQF* website. Please see the README.TXT file 
in the ..\CONTEST subfolder of your Win-EQF* program folder for further details. 

3. Added the Scandinavian Activity Contest (SAC) contest definition files to the 
CONTEST.ZIP library. Tnx LA6ZDA.

4. Improved support for the UBA Spring- & ON contest. Tnx ON6KN.

5. Added .RIG definition file for the Yaesu FT-5000. Tnx HA5WA and HA7TM. 

6. Minor bug fix in the CONTEST module.

7. Added Alt-Q as keyboard shortcut to look up callsign via the free web service of 
QRZ.com. 

8. Added Alt-B as keyboard shortcut to look up callsign via the free web service of 
Buckmaster / hamcall.net. 

9. Now hiding LoTW status fields in LOGBBOK DETAIL VIEW and LOGBOOK DETAIL PRINT if 
user has opted to hide the LoTW fields on the logging screen. 

10. Default printer font changed to ARIAL due to problem with long lines on QSL 
labels.

11. Changed order of QSL SENT codes when hitting F8. 

12. Minor changes to PREFIX.LIB. 

13. Revised QRZ.com and hamcall.net database lookup routines. 

14. Minor change to the PATCH install routine. 

15. Minor change in GOLIST lookup / LoTW info no longer placed in the log's INFO 
field.

16. Corrected URL in Help > Check for upgrades. 

Changes in Win-EQF* v. 2.04 - September 19, 2010

1. Minor bug fixes.
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Changes in Win-EQF* v. 2.03 - September 18, 2010

1. Fixed remaining causes of program lock-up when running Windows XP/SP3.

2. Fixed bug in IOTA award tracking module and revised IOTA.LIB. 

3. Minor cosmetic improvements in a few dialogs. 

4. Added CONTEST.60 for the WA State Salmon Run contest (for WA stations).

5. Added CONTEST.61 for the WA State Salmon Run contest (for non-WA stations).

PLEASE NOTE: When entering calls for stations that are on a county line, i.e.

receive credit for both counties) OR stations who are mobile through several 
counties, you MUST enter the call with a "/County" or they will record as DUPES.

Example: W7DX/BEN, W7DX/OKA, etc.

Please refer to the http://www.wwdxc.org web site for details regarding the WA 
State Salmon Run contest; the contest definition files are provided as a first-
version only and feedback on their validity is appreciated. Enjoy your smoked 
salmon. 

Changes in Win-EQF* v. 2.02 - September 17, 2010

1. Fixed bug in the contest module, causing program lock-up when running Windows 
XP/SP3.

Changes in Win-EQF* v. 2.01 - September 15, 2010

1. Adjustments to new versions of the PowerBASIC compilers (PBCC v. 2 -> 5, PBWin v. 
6 -> 9). 

2. Added .RIG definition files for the Icom IC-7600 and FlexRadio SDRs. 

3. Changed File-EQF* default file extension for export to ASCII (Commas) from ".DAT" 
to ".CSV". 

4. ProgramID for ADIF export updated to reflect new product name. 

5. Changed routine for pasting text. Now, any clipboard text containing a DOUBLE 
carriage return + line feed (CRLFCRLF) is changed to CRLF only during PASTE. In 
earlier versions, when copying an address from e.g. QRZ.com, a number of seemingly
empty lines would appear in Win-EQF's notepad. Now, the "empty" (CRLFCRLF) lines 
are gone and the QSL manager's address can be pasted directly into the notepad 
without manually removing the "empty" lines. 
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6. New functionality in AUTOMATIC/MANUAL logging (not operational in CONTEST mode); 

Alt-P invokes Ham CAP (http://www.dxatlas.com), if installed, with propagation 
prediction between you and the DX station.

Alt-D invokes DXAtlas (http://www.dxatlas.com), if installed, with a great circle 
line between you and the DX station's QTH.

Alt-G invokes your web browser and Google Maps, centered on the DX station's QTH.

Alt-X invokes EQFSHELL.BAT. Please refer to comments embedded in the EQFSHELL.BAT 
file for details. 

7. In Win-EQF.INI, the GENERAL section now supports optional setting ConnectIonoProbe
(set to ON or OFF).

When set to ON, interaction with Ham CAP (see above) will also get the latest 
ionospheric conditions as provided by IonoProbe (http://www.dxatlas.com). 

8. In the Contest menu, added menu item to open WA7BNM's contest calendar (or any 
other contest calendar - you can specify the URL in the Win-EQF.INI file, GENERAL 
section, KEY ContestCalendarURL). 

9. The window close (X) button in the upper-right corner of the Win-EQF* window has 
been disabled. This ensures that Win-EQF* will (almost) always exit in a graceful 
way. 

To exit Win-EQF*, please select File > Exit (or simply press Alt-F to enter the 
"File" menu and then X to select "Exit"). 

10. Minor changes to the IARU Region 1 bandplan file. Added bandplan file for Norway. 

11. Printing of QSL labels, minor logic changes:

- If nothing entered in the "MGR" field, labels will be printed as in earlier
versions.

- If "DCT" or "DIRECT" is entered in the "MGR" field, labels will contain 
callsign + "(DCT)".

- If something else (manager callsign) entered in the "MGR" field, labels 
will contain callsign + "VIA" + manager callsign.

In short: use the "MGR" field for either NOTHING, "DCT", "DIRECT" or MANAGER 
CALLSIGN. (Q: How about "direct QSL, but via manager"? A: Until further - you'll 
have to take care of that yourself). 

 Additional whitespace inserted between "DATE" and "2WAY" on QSL labels.

12. LoTW user lookup, provided by GOWIN and/or QRZ.com. Instantly know whether the 
station you're logging is a known LoTW user.

Requires the GOWIN application and GOLIST data subscription 
(http://www.golist.net) or a QRZ.com XML data subscription (http://www.qrz.com). 

13. On QSL labels, modes "LSB" and "USB" are no longer replaced with "SSB" during 
printing. 

14. Minor changes in a number of dialogs.

15. New Win-EQF* icon.

16. Added licensing/registration control.

17. Comprehensive FAQ placed in the SUPPORT section of the web site; http://www.win-
eqf.com.

18. When EDITING an existing QSO, F9 now cycles between available values for QSL 
RECEIVED.

The same logic is applied to F8 (QSL SENT).  

19. "GOLIST Issue" is now shown as "GOLIST #" followed by four-digit issue number, 
previous versions were limited to three-digit issue numbers. 

20. Fixed a minor bug related to the contents of the MODE field, when selecting a spot
from the DX Cluster screen. 
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21. Fixed bug in screen repaint during EDIT QSO.

22. Fixed bug in contest mode, no overwrite of INFO and RATE fields with DXCC info 
and/or ZONE info.

23. Fixed bug which caused delayed update of bottom line (operator callsign) after 
selecting a different operator. 

24. Fixed annoying bug when Ctrl-L/Ctrl-W used in conjunction with F3 Net/Roundtable.

25. Fixed bug in detailed logbook view if entering a non-existing QSO number to edit. 

26. Fixed bug in contest mode, GOLIST data cluttering the multiplier screen.

27. Fixed bug in contest ASCII results print, date format now in accordance with user-
selected preference. 

28. Fixed bug in pulldown menu system. 

29. Fixed screen repaint bug when exiting to the command line.

30. Changed appearance of user notification of existing NOTEPAD entry when in EDIT 
mode.

31. Minor updates to PREFIX.LIB (prefix library). 

32. Updates to IOTA.LIB (IOTA islands library is now in accordance with the RSGB IOTA 
list as of August 26, 2010). 

33. Courier New is set as default font for printing. 

34. In normal logging, after acknowledging DUPE QSOs with ENTER, the callsign in 
question is now pre-filled into the

Ctrl-E (search for callsign to EDIT) dialog. 

35. When a QSL manager is returned from the GOWIN program, the "MGR" field is 
automatically highlighted.

36. The CW KEYER section contains an optional setting WinKeySWSpeed which can be set 
to ON or OFF. 

When set to ON, Win-EQF* will store and retrieve the keyer speed from the Win-
EQF.INI file, setting the 

WinKey speed accordingly upon program startup. Any potmeter speed change will be 
ignored. 

Handy feature for those who are hooked up to a WinKey chip without hardware speed 
control. 

37. During automatic logging, the TRACK field will under certain conditions be auto-
populated with the name of the connected rig (if any). Please refer to the manual 
for details. 

38. Removed non-essential items from the HELP menu.

39. Added a new item in the Win-EQF* start menu program group - shortcut to the user's
manual. 

40. Added support for the Belgian Spring Contest (CONTEST.59). 

41. New install routine.

42. Help file updated.

43. Documentation updated, now included as a PDF file containing the user's manual. 

44. Ref. v. 1.49 (13); VUCC award tracking now counts entries with ARRL checked QSL 
RECEIVED status ("A" in the QSL RCVD field) even if QSL SENT is set to "P". 

45. Minor changes in all AWARDS modules.
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1.1.2. Internet presence & contact information

Please note that the home of Win-EQF* on the internet is http://www.win-eqf.com. 

There's a comprehensive FAQ available at the website which answers the most common 
questions related to Log-EQF / Win-EQF / Win-EQF*. 

From the Win-EQF* website you will find a link to the Win-EQF* Google Group, which 
you're most welcome to join. 

Author contact information:

Torkel M. Jodalen, LA6VJA
P.O.Box 1036 Jeløy
NO-1510 Moss
Norway

1.1.3. User feedback

General user feedback, feature requests, suggestions, etc.  – please feel free to post them
on the Win-EQF* Google Group. Indeed, user feedback is encouraged – that's the best 
way to improve Win-EQF*. 

1.1.4. License agreement

Win-EQF* is licensed as donationware. If you like it, please support further program 
development. The Win-EQF* license agreement is available during the install procedure 
and from the Help > Software license menu item. 
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1.1.5. Cease of support for Win-EQF version 1.xx

After Feburary 28, 2011, Win-EQF version 1.xx is no longer supported. 

Users who have decided not to upgrade their Win-EQF v. 1 program are encouraged to 
make appropriate backup copies of their software, as replacement downloads are no 
longer available. Please note that the Win-EQF* Google Group will remain open for 
questions and comments related to Log-EQF, Win-EQF and Win-EQF*. 

1.1.6. End of Win-EQF* commercial life

Effective as of December 1, 2014, Win-EQF* will no longer be commercially available.  
Win-EQF* remains available as DONATIONWARE. 

Please refer to the Win-EQF* web site and the HELP > SOFTWARE LICENSE menu item 
for details. 
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1.1.7. Final words ...

Our Win-EQF* Google Group is monitored by very experienced and long-time, helpful and 
dedicated Log-EQF / Win-EQF / Win-EQF* users, quickly answering most questions that 
are posted there. 

No email support is offered. Whatsoever. 

73  & GL

DE

LA6VJA
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Whatever you do before or after downloading version 3 of Win-EQF*, please make 
backup(s) of your logbook files (File > Backup logbook or manually copy your 
..\LOGS folder and WIN-EQF.INI file to a USB memory stick or different folder) before 
installing version 3.

Win-EQF* version 3 is not a patch to existing Win-EQF 1.xx installations, meaning that it 
will overwrite whatever exists in the target directory – if installed to the same location as 
where you have version 1.xx. 

PLEASE DO NOT ATTEMPT TO PATCH A VERSION 1.xx INSTALLATION WITH A 
VERSION 3 PATCH. IF YOU DO, YOU'LL END UP WITH A USELESS PROGRAM. 

Please pay attention to this, as you may also have macro files (.KEY), CW keyer files 
(..\KEYER\*.*) and custom label definitions  (DDOCML.INI) which will also have to be 
backed up before installing version 3. The contents of these folders will be overwritten 
during installation of version 3 !
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